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Digital Elevation Model (DEM) Creation and Analysis

Name(s)

Objective:

In this lesson, you will create a DEM from interpolating elevations on a topographic map.
You will then understand more fully what a DEM is and how it can be used. Then you will download
a USGS DEM from the Internet and analyze it within GIS software.

Required Materials:
1 USGS topographic map (quadrangle) of an area of interest to you
1 sheet of mylar or translucent graph or tracing paper at least 10" x 10"

Software Used:
Arc8.1 or later, ESRI.
Spatial Analyst extension, ESRI
3D Analyst extension, ESRI

Skills Involved:
1. Interpolating elevations.
2. Creating a DEM from interpolated elevations.
3. Downloading and formatting a USGS DEM.
4. Performing raster analysis on a DEM.
5. Creating derivative data from DEMSs.

. Sampling Elevation Data from a Topographic Map
In this lesson, you will create a Digital Elevation Model (DEM). A DEM is a gridded array of

elevations, and in its raw form, is an ASCII, or text, file. Obtain a printed topographic map or print
one from teraserver-usa.com or from|www.topozone.com| such as the one below.
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http://www.topozone.com/
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Create a folder in your network drive called dem. This is where data for the first part of this lesson
will be stored.

Draft a 10" by 10" grid with 1" subdivisions on mylar or translucent paper, as below, or use graph
paper that is already gridded in one inch squares. This will be your guide in sampling elevations
from the topographic map. Set up the coordinates as shown below, with rows numbered on the left
side and columns numbered across the bottom:
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Before you continue, familiarize yourself with the map sheet you have chosen.

1) What is the name of the quadrangle?

2) In what state(s) is the quad located?

3) Whatis the map scale?

4) What is the contour interval?

5) What are the contour units (m or ft)?

6) What is the UTM zone for your map?

In a DEM, elevations are sampled at regular intervals in the x and y dimensions. A typical USGS
7.5' DEM contains elevations every 30 meters, although many others sample elevations every 10m
or even 5m. Your horizontal interval is 1" on the map.

7) Given the scale of your map, 1 inch on the map is equivalent to how many meters on the
ground?

meters.
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Therefore, this is your sample interval, sometimes referred to as the "resolution" of a DEM.

Position your grid over an area of the map that interests you. It does not matter where you place the
grid, just make certain that the grid is completely within the map boundaries. When the grid is in
position, tape it to the map sheet (using drafting tape if you want to avoid damaging the map). At
each intersection point on the grid, record the approximate elevation in integers only (no decimal
points).

Il. Entering Data Into a File

The elevation data you have recorded on your grid will be brought into ArcGIS as an ascii (text) file.
You may use any word processor, NotePad, or WordPad, as long as you save as text.

Recall that raster files need a header, or world file, information that "registers" the file to the correct
coordinate space. The header information for your DEM grid will be at the beginning of the data,
rather than in a separate file. It will have the following format:

ncols <value>

nrows <value>

xllcorner <value>

ylicorner <value>

cellsize <value>

nodata_value -99

5280 5283 5271 etc [these are the data; the elevations]
4986 4991 4994 etc

The "ncols" is the number of columns; nrows is the number of rows.
The xlicorner is the x coordinate of the center or lower-left corner of the lower-left cell. (southwest)
The ylicorner is the y coordinate of the center or lower-left corner of the lower-left cell (southwest).

8) What is the correct value of ncols for the data you will enter for the DEM you create?

9) What is the correct value of nrows for the data you will enter for the DEM you create?

10) What is the value of the cellsize you will enter (refer to the resolution of your data above)?

Access WordPad or another editor.

Make one row of elevation data for each row in the data, to more easily visualize the process.
Spaces are the delimiters between cell values.

The first row of data should be at the north end of the data set, moving from left to right (west to
east). Therefore, the first entry should be for the northwest corner, coordinate 0,9.

11) What is the total number of cell values you will enter?
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You can visualize the data entry on the chart below, enter your interpolated values in the cells, and
use the chart to keep track of the values you have already entered.

0,9 19 129 39 149 59 169 179 8,9 9,9

0,8 18 [ 28 3,8 4,8 5,8 68 |78 8,8 9,8

0,7 1,7 | 27 3,7 4,7 5,7 6,7 | 7.7 8,7 9,7

0,6 16 [ 26 3,6 4,6 5,6 66 |76 8,6 9,6

0,5 1,5 [ 25 35 145 55 65 175 8,5 9,5

04 |14 |24 |34 |44 |54 |64 |74 |84 |94

0,3 1,3 123 33 143 53 163 |73 8,3 9,3

0,2 12 |22 3,2 4,2 5,2 62 |72 8,2 9,2

0,1 1.1 [ 21 3,1 4.1 5,1 6,1 | 7,1 8,1 9,1

0,0 1,0 [ 2,0 3,0 4,0 5,0 6,0 | 7,0 8,0 9,0

Save the file as elevations.txt in plain text format.

12) What is your lowest and highest elevation value (give the units, also)?

13) Print your elevation file and include with these lesson sheets.
lll. Creating a DEM in ArcGIS from your text file.
To create a grid from your elevation file, access ArcToolbox.

Under Conversion Tools, use Import to Raster, and ASCII to Grid. Give your grid an appropriate
name, but without spaces.
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14) Go to Windows Explorer and indicate the names and the contents of each file that has now
been created:

Next, define a projection for your data using the Define Projection Wizard that works on the type of
file you now have (a grid). Give it the UTM zone that you indicated above with a datum of NAD83
CONUS - Conterminous US (unless you are working in Alaska or Hawaii).

15) Go to Windows Explorer again and indicate the name of the new file that was created after you
defined the projection.

16) What do you think the contents are of this file?

Close ArcToolbox.
Access ArcMap with a new map document.

Engage the Spatial Analyst and 3D extensions so that you will be able to work with your DEM as a
surface. (Under Tools).

Go to View—> Toolbars and turn on the Spatial Analyst and 3D toolbars.
Add your grid as a data set.

17) Make 3 observations about the results.

18) Change the symbology to “stretched” with a grayscale, and describe the result.

Set the map and distance units of the data frame to meters.

Use the measure tool to measure a cell.



Creating and Analyzing a DEM - May 2004 - Author : Joseph J. Kerski — jikerski@usgs.gov - Page 6 of 14

19) What is the width of each cell?

20) Why?

21) How large is each cell? This is the spatial resolution of your data set.

Under layer properties for your grid, look under source.

22) What is the minimum and maximum of your data? Why?

23) What is the mean of your data?
Scroll with your mouse to each corner and note the coordinates.

24) Which corner corresponds to the coordinate system value that came from your original text file?
Why?

Look under the Extent tab in the properties for your grid layer.

25) What are the minimum and maximum x and y extents? Why?

Save your map document in your dem folder.
Use the identify button to identify a few cells.
Use the measurement tool and measure each cell.

26) How large is each cell?
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27) Why?

Open the attribute table for your grid.

28) How is the grid stored? Describe.

29) Does each cell in the grid have a corresponding row in the attribute table?

30) Indicate why you cannot label each cell.

31) Create a layout of your grid and print, with your name and an appropriate title. Turn in with
these lesson sheets.
Now you're ready for some 3D analysis!

On the 3D toolbar, access ArcScene (the last button).

Add your grid into a new ArcScene. Rotate around the grid.

32) What is the problem?

Therefore, you need to set the heights of the data to the surface. Go to the layer’s properties, and
under base heights, click the box “obtain heights for layer from surface” and indicate the grid
surface. Under Z unit conversion, apply a custom vertical exaggeration, say, 15, for starters.

33) Describe the result.
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33) Experiment with different z-exaggerations and indicate which you believe is most appropriate for
your data.

Convert the grid to a Triangulated Irregular Network (TIN) using the 3D Analyst toolbar, and
Convert-> Raster to TIN. Take the defaults.

Turn off your grid and turn on the TIN.

Zoom to the full extent of it using the globe tool.

34) Make 2 observations about the TIN.

35) Go to File> Export Scene and create a 2D file of your TIN. Export to a JPG or other format that
you can bring into MS Word or a graphics package of your choice. Import the JPG and print the file
with your name and an appropriate title. Turn in with these lesson sheets.

Save your 3D scene in your DEM folder.

36) What file extension does an ArcScene have?

Save your ArcMap map document again in your DEM folder. Close ArcMap.
IV. Downloading and Formatting a USGS DEM in ArcGIS.

You have created your own DEM. In the next section of the lesson, you will download a USGS DEM
from the Internet, format it for use in ArcMap, and analyze it.

First, create a folder named “blair,” because you will be analyzing data in Blair, Nebraska. Land of
the Loess!

You need to find the county that Blair is located in so that you can go to the appropriate location to
download the data. The USGS maintains a site that indicates millions of names on all of its
topographic maps.

Access the following site:

http://geonames.usgs.gov|

Go to US States and Territories and enter Blair, and limit the search to “Populated Place” field type.


http://geonames.usgs.gov/
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Find Blair Nebraska in the listing.

37) What county is Blair in?

Now you are ready to download the DEM for Blair.

Go to the following site:

http://www.gisdatadepot.com|

Go to “Download GIS Data — Enter Here.”
Click on Nebraska.

Go to the county you indicated above and then to DEM — 24K.
Go to the GREEN BUTTON and access the 10 meter DEM for Blair.
This should be the file:

1673840.DEM.SDTS.TAR.GZ| (10 meter)

Save this file to your blair directory.

Unzip this file. Click “yes” if prompted “should Winzip decompress to a temporary folder”.
Access Windows Explorer.

38) What is the file extension for most of the files you just unzipped?

39) What are the four numbers that begin most of the file names?

The extension indicates that these files are in SDTS, or spatial data transfer standard, format. Each
SDTS set of data has a unique 4 digit number. Before you can use these data, you'll need a
translator to convert them from an SDTS-formatted DEM to a standard DEM.

Access ArcToolbox and find “Import to Raster” under Conversion Tools. Use SDTS Raster to Grid.
Use the number you indicated above as the 4-digit prefix.

Name the output grid blairdemgrid.
Use Windows Explorer to examine your blair folder.

40) What effect did the above ArcToolbox GRID creation have on your folder?


http://www.gisdatadepot.com/
http://dl1.geocomm.com/download/6654/1673840.DEM.SDTS.TAR.GZ
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Close ArcToolbox.

Next, you will examine the coordinate system for your data. The data, as most USGS data, is in the
UTM coordinate system. You need to determine the zone for the data.

Go to the location:

http://mac.usgs.gov/mac/isb/pubs/factsheets/fs07701.html|

Scroll down to examine the UTM zones for the conterminous USA.

41) Most of eastern Nebraska is at the eastern edge of what UTM zone?

42) Access ArcCatalog and navigate to your blair folder. Examine the file blairdemgrid. Look at the
file with the Preview tab. Where are the lowest elevations in the Blair area?

43) Under metadata, look at the Spatial tab. What UTM zone is the data in?

44) How does this compare to what you examined on the map on the USGS web page, above?

Close ArcCatalog.
V. Analyzing a DEM in ArcGIS.

You are now ready to analyze your DEM and create some derivative data sets that you need to
address a real-world problem.

Access ArcGIS—> ArcMap.

Create a new map document. Turn on the 3D and Spatial Analyst extensions and toolbars if they
are not already on.

Add the Blair grid as a layer.

45) Scroll around the DEM with the mouse, taking note of coordinates and make two observations
about them.

46) Use the identify button to indicate the approximate elevation of most of the floodplain in the
northeast part of the image.


http://mac.usgs.gov/mac/isb/pubs/factsheets/fs07701.html
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Open the attribute table.

47) What is the most common elevation in the data set?

48) Is this DEM an integer grid or a floating point grid? How does that compare to the DEM grid
that you created yourself?

49) How many cells have this elevation?

50) What is the highest elevation in the data set?

51) In what part of the map is the highest elevation? How did you locate it?

Create contours from the DEM. Use the Spatial Analyst toolbar, under Surface Analysis, Contour.

52) What should your base contour be, and why?

53) Describe the resulting contour map and attribute table, and the type of file (raster or vector) that
it is.

54) How many contours did you create?

Save your map document with an appropriate name in your blair folder.
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Under the “surface analysis” menu again, use “compute hillshade” to create a shaded relief from
your DEM. Save the result in your folder.

If you would like to, experiment with the settings for hillshades.

55) Make 2 observations about the terrain of this area of Nebraska.

56) Is the hillshade a vector or a raster file?

Use the same menu to derive an aspect from the DEM.

57) What does the term “aspect” refer to? lIs it a vector or raster file?

58) How many degrees on the compass is due south, based on your observations here?

Use the same (surface analysis) menu to derive a slope map from the DEM.

59) What is the maximum slope in the Blair quadrangle? [and you thought Cornhuskerland was
flat!]

60) Are the slopes in degrees or as angles?

Save your map document.

VI. Analyzing a DEM in 3D

Tools—> Extensions. Turn on the 3D extension.
View-> Toolbars. Turn on the 3D toolbar.

On the 3D toolbar, access ArcScene (the last button).
Add your DEM grid into a new ArcScene.

Rotate around the grid.



Creating and Analyzing a DEM - May 2004 - Author : Joseph J. Kerski — jikerski@usgs.gov - Page 13 of 14

Via Layer Properties: Set the base height of the data to the DEM surface as you did for your own
DEM that you created. Experiment with the vertical exaggeration.

61) Describe how you accomplished this.

62) Experiment with different z-exaggerations and indicate which you believe is most appropriate for
your data.

Add a digital raster graphic or a digital orthophotoquad as a layer.

Set the base height equal to the DEM surface. Exaggerate the vertical to the same amount as your
base DEM.

63) What is your vertical exaggeration and the offset?
Offset the DRG or DOQ slightly from the surface.

Convert the grid to a Triangulated Irregular Network (TIN) using the 3D Analyst toolbar, and
Convert-> Raster to TIN. Take the defaults.

Turn off your grid and turn on the TIN. Zoom to the full extent of it using the globe tool. Under the
TIN’s layer properties, use the base heights from the new TIN and experiment with the z
exaggeration.

64) What z exaggeration do you feel is best to visualize the land surface?

65) Make 2 observations about the TIN.

66) Go to File> Export Scene and create a 2D file of your TIN. Export to a JPG or other format that
you can bring into MS Word or a graphics package of your choice. Import the JPG and print the file
with your name and an appropriate title. Turn in with these lesson sheets.

Save your 3D scene in your DEM folder.

Save your ArcMap map document again in your DEM folder.
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67) Summarize what you learned about DEMs in this lesson.

68) Summarize what you learned about ArcGIS in this lesson.

Close ArcMap.

*** End of Lesson ***
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